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Executive summary

This white paper provides instructions for installing the Microsofft® Windows® 7 Professional and
Microsoft Windows XP Professional operating systems (OSs) along with applicable HP drivers and
applications on select HP EliteBook and HP ProBook Notebook PC models. Instructions are also
provided for creating a common image for 2012 HP Business Notebook PCs.

Target audience: This white paper is intended for IT staff.

System requirements and prerequisites

Information regarding minimum hardware requirements for the installation of Windows is available at
http://www.microsoft.com.

Supported models

HP EliteBook 2170p Notebook PC
HP EliteBook 2570p Notebook PC
HP EliteBook 8470p Notebook PC
HP EliteBook 8470w Notebook PC
HP EliteBook 8570p Notebook PC
HP ProBook 6470b Notebook PC

HP ProBook 6570b Notebook PC

WARNING

Before proceeding with the installation of Windows, you should back
up all personal data, such as files, photos and videos. If it is not
backed up, your personal data will be lost.

The following items are needed to install Windows:

e A supported HP business notebook PC model
e Windows OS recovery media provided by HP

- Media from an alternate source may require a product ID (PID)’
e Access to Drivers/OS enhancements provided by HP

— HP SoftPaq Download Manager (www.hp.com/go/sdm)

— High speed Internet access (www.hp.com)
— HP Driver Recovery DVD (DRDVD)

' Typically provided on the product's Certificate of Authenticity


http://www.microsoft.com/
../2011/Approved%20by%20legal/www.hp.com/go/sdm
../2011/Approved%20by%20legal/www.hp.com

IMPORTANT

Make sure you have the latest compatible versions of drivers and
enhancements (Table 1). In addition, you must have a Microsoft
operating system license for each system on which you install
Windows XP Professional or Windows 7 Professional. The Windows
7 Professional license allows you to use Windows 7 Professional,
Windows XP Professional or Windows Vista Business.

Installing the OS, drivers, and enhancements
This section provides guidelines for users performing a clean installation of Windows on a supported
HP business notebook PC.

For more information on installing Windows, refer to the Microsoft website at
http://windows.microsoft.com/help.

IMPORTANT

Follow the installation instructions in the order provided. Failure to
complete these steps in the proper order can result in an unsuccessful
or unstable installation. These instructions are independent of the
operating system currently installed on the notebook PC.

1. Depending on the particular Internet connection(s) being used, download the driver(s) for the
network interface card and/or wireless LAN adapter driver. Save to a USB storage device or
optical media.

— Contact your network administrator to properly set up the networking components of Windows.

2. Change the boot order in F10 Setup so the optical drive is the first boot device.

3. Boot with the Windows OS recovery disk provided by HP; follow the on-screen instructions for
installation.

— OS recovery media from HP does not require a product ID or key for installation on a supported HP
business notebook PC.

— HP recommends that you retain the HP_TOOLS partition to provide support for HP Quicklook, the
F10 Setup graphical user interface, and HP diagnostics. For more information, refer to the white
paper, “HP Business Notebook Computer EFI Guidelines.”

— Older Windows XP OS media does not include serial ATA (SATA) drivers. For more information on
loading SATA drivers, refer to the white paper, “Moditying a Windows XP installation to support
SATA Native Mode on HP Business Notebooks.”

— If using Advanced format hard drives (4K sector drives), please refer to the HP white paper

“Preparing Advanced Format hard drives for Microsoft Windows installations on HP Business
Notebook PCs and desktop PCs.”

4. Install the appropriate communications driver from either the Driver Recovery DVD or USB storage
device (Step 1 above) and configure your Internet connection.

— For Windows XP, install the Microsoft Universal Audio Architecture (UAA) Bus Driver and Essential
System Updates, then reboot prior to installing the audio and modem drivers. The audio driver may
require manual installation. (NOTE: The Universal Audio Architecture (UAA) Bus driver is integrated
into Service Pack (SP) 3 and does not need to be installed separately).

3


http://windows.microsoft.com/help

5. Install the desired patches from www.microsoft.com/windowsupdate or contact your network
administrator for additional updates. Reboot the system after these patches have been installed.

- For Windows XP, you must install Microsoft DirectX 9 and possibly Microsoft .NET Framework.
For more information on .NET dependencies, refer to Table 1 below.

6. Install the drivers and enhancements listed in Table 1 using HP SoftPaq Download Manager
(available from www.hp.com/go/sdm); alternatively, you can download individual SoftPags from
the HP website.

For more information, refer to Appendix A: Using HP SoftPag Download Manager.

IMPORTANT
To prevent possible data loss, HP recommends you adjust your
power management settings prior fo using the notebook.



http://www.microsoft.com/windowsupdate
http://www.hp.com/go/sdm

Drivers and enhancements

Table 1 lists minimum recommended drivers and enhancements for Windows 7 Professional and
Windows XP Professional. The table also includes dependencies on .NET Framework (if applicable).

Table 1. Minimum recommended software versions

Name Version XP Win 7 Priority 'NE.T
Required
Driver — Audio
o Required 3.0
IDT HD Audio Driver 1.00D X X
Driver — Chipset
Required N/A
Intel® Chipset Installation Utility 9.3.0.1020 X X
ntel M Encine C Required 3.5 SP1 or
nt.e anagement Engine Components 8.0.10.1464 B X X q greater
Driver
Required N/A
Intel USB 3.0 Driver 1.0.4.225 A X X
Driver — Graphics
Required 3.5 SP1
AMD Video Driver and Control Panel 8.951.6 A X X
i i Required 3.0
Intel HD Graphics with Turbo Boost 8.15.10.2712 X equire
Technology
Intel Video Driver and Control Panel for Required 3.0
Windows XP 6.14.10.5407 X
Driver — Keyboard/Mouse/Input
Recommended 3.5 SP1 or
HP Hotkey Support 459.1A X X greater
Required N/A
HP Universal Camera Driver 4.00 A X X
Required N/A
Synaptics Touchpad Driver 16.0.3T X X
T . . Required N/A
Validity Fingerprint Driver 4.4213.0A X X
Driver — Modem
Required N/A
LSI HDA Modem Driver for Windows 1.00D X X
Driver — Network
Atheros AR3012 and AR9462 Bluetooth 100 A X X Required N/A
+HS 4.0
] ) Required N/A
Atheros AR9462 Wireless LAN Driver 1.00 A X




Name Version XP Win 7 Priority 'NE.T
Required
Required N/A
Atheros AR9485 Wireless LAN Driver 1.00 B X X
. 3.0o0r
. Required
Broadcom 2070 Bluetooth for Windows 7 6.5K X X greater
. 3.00r
;B(rPoctdcom 2070 Bluetooth for Windows 56F X Required greater
i ili Required N/A
Broadcom WLAN Driver and Utility 5100.82.130 X X equire /
Package
Required N/A
Ericsson Mobile Broadband Drivers 7.2.0.10A X X
Intel 82579LM and 82579V Gigabit 1.00D X X Required N/A
Ethernet Driver for Microsoft Windows ’
- ) . Required N/A
Intel My WiFi and Wireless Drivers 15.1 A X
Sierra Wireless Driver Package for HP Required N/A
un2430 Mobile Broadband Module 1.0.35.08 X X
Driver — Storage
Required N/A
Alcor Micro Smart Card Reader Driver 1.7.28.0 A X X
. 3.5 SP1 or
. . Required
Intel Rapid Storage Technology Driver 11.1.0.1006 X X greater
. . . Required N/A
JMicron Media Card Reader Driver 1.0.68.0 A X X
Software - OS Enhancements/QFE’s
Essential System Updates for Microsoft Required N/A
. 2.0.6 X
Windows 7
Essential System Updates for Microsoft 41E X Required N/A
Windows XP ’
Software — Security
7.0.000.2882 Recommended
Embedded Security for HP ProteciTools A X X N/A
Recommended 3.5 SP1
Privacy Manager for HP ProtfectTools 7.0.0.865 A X X
Software — Solutions
) Required N/A
HP 3D DriveGuard 5.0.8.0A X X
. 3.5SP1 or
Required
HP Software Framework 45.10.1TA X X greater
Software — System Management
Recommended N/A

System Default Settings for Windows 7

2.4




Priority Key
Required Mandatory for optimal hardware support
Recommended HP recommends installing for optimal system performance
Optional Value-add software for desired solution
NOTE

Some deliverables may have direct dependencies on other
deliverables that may require .NET.

Building a common image

Instructions are provided for building Windows XP Professional and Windows 7 Professional images.

Windows XP Professional

1. Install Windows XP Professional on a supported platform.
2. Install the following and then reboot the system:

— Essential System Updates for Windows XP

- System Default Seftings

- Microsoft Universal Audio Architecture (UAA) High Definition Audio class driver (not required for
XP SP3)

- Microsoft .NET (refer to Table 1 for .NET version requirements)
3. Copy the i386 folder from the Windows XP installation DVD to the root of %SystemDrive%.

4. Extract deploy.cab from the SUPPORT\TOOLS\ folder of the install DVD to the
%SystemDrive% \sysprep folder.

5. Copy all device drivers to a common folder location (i.e. %SystemDrive%\DRV).
6. Run setupmgr.exe from the %SystemDrive%\sysprep folder to create a sysprep.inf file.
7. As shown in Figure 1, make the following changes to the sysprep.inf file.

- In the [Unattended] section —

Change InstallFilesPath to %SystemDrive%\i386.

The OemPnPDriversPath should include paths for all .inf installed drivers.
- In the [SetupMgr] section —

Change DistFolder to %SystemDrive%\i386

NOTE
Figure 1 does not show the complete sysprep.inf file.




|
Figure 1. Updating the sysprep.inf file

[Thattendad]
OemSkipEula=No

OenPnPhriversPath =

"Drvh Video Drvy\Nic:Drvhindio;DrviModen ;D\ Miscl ;Drvh MiscE; Derv i\ Misc3 ;Drv\ Miscd ;Drvi\ Misc B Drw
WChipset ;D\ EED ;Devh MED Dy USE ;Drv i Netwmork "

InstallFilesPath = "C:yizse"

[SetuplGR]
DistFolder = c:%i386

8. Run the following command:

sysprep —mini —shutdown —reseal

9. After shutting down the system, use hard-drive duplication software to deploy the common image.

Windows 7 Professional

1. Install Windows 7 Professional on a supported platform.
2. Install the following and then reboot the system:
— Essential System Updates for Windows 7 SP2
— Windows 7 Default Settings
3. Copy all device drivers to the %SystemDrive%\DRV folder.
4. Run Windows System Image Manager to create the sysprep.xml file.
5. As shown in Figure 2, make the following changes to the sysprep.xml file:

- In the Microsoft-Windows-PnpCustomizationsNonWinPE component —
Set the PnP driver search path.

- In the Microsoft-Windows-Deployment component —
Following the pass="auditUser” phase, set Reseal in OOBE mode.

NOTE

Figure 2 does not show the complete sysprep.xml file.




Figure 2. Example of sysprep.xml file

<Zzml version="1.0" encading="uH-3"3 >
<uratiend xmlns="urn:schemasmicros oftcom wnatend "=
<seftings pass="aud iBystem ">

<component mme="kicros oftWind ow s-Frp Customizations MonWinPE" processordrchitechre="=5a"
publickeyToker= "3 1b{35580d 364235" language="neutral" versionScope="nonS:x3"

#m Insw cm="htp: /fschemas microsoft.com AWia Co nfig /2002 / State" xminsssi="http ./ www w3.0rg /2001 SHMLSchema-

instance"z
<LriverPats =
<Pathdnd Credertiak wem keyWalbe="dbbHZ1" wem action="add"=
<Path=ChDiree/ Pathi-
</ PathtndCredential:=
o Driver Paths =
</component>
< fsettings =
<seftings pass="aud illser"=

<component rame="Micros ot Wind ow s-Dep bymert” processordrchitechre="<55"
publickeyToker= "3 1b{38580d 364235" language="neutral" versionScope="nonS:x3"

=mInsw em="htp: /fschemas microsoft.com Mia ICo nfig /2002 / State" «minssei="http ./ www w3.0rg /2001 SHMLEchema-
instance">

Reseal=

<ForceShutdow n Mo watolees Forces botdo wn Mows
<hiode=O 0B B Mo dex
</ Reseqbs

<fcomponents
< fsettings =

6. Copy sysprep.xml to % SystemDrive%\Windows\System32\Sysprep.
7. Run the following command:

sysprep /generalize /audit /shutdown /unattend:sysprep.xml

8. After shutting down the system, use hard-drive duplication software to deploy the common image.



Appendix A: Using HP SoftPagq Download Manager

Using HP SoftPaq Download Manager to update the current platform
Boot the Windows OS.

Open Microsoft Internet Explorer.

Download and install HP SoftPaq Download Manager from www.hp.com/go/sdm.

Launch SoftPaq Download Manager.

O x> @ =

When prompted, select Show software for this model only (Figure A-1).

NOTE

Use the Check software updates for this model option to
automatically install the updates on the current system or to
download SoftPags to install on systems similar to the current
platform.

Figure A-1. SoftPaq Download Manager menu

S
HP SDM is an efficient way of obtaining software and drivers

for HP business computer models.

() Check software updates for this model.

@ Show software for this model only.
(") Show software for all supported models.
[ Do not show this again

6. The current platform will automatically be displayed and selected in the Product Catalog window.
7. Select the desired SoftPags from the Available SoftPags list (Figure A-2).
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Figure A-2. Available SoftPags list

Available SoftPaqs
@ Select SoftPaqs ~ Search for hardware ID Q Show Latest SoftPaqs
Name Version -
[™] HP Universal Camera Driver CP58500121_F760000z
[7] HP USB 2.0 Docking Station Drivers 5.5.27797.0
[] HP Wireless Assistant 4042
[] IDT High-Definition (HD) Audio Driver 5.10.6268.0; 6.10.6268.
[7] Language Locale ID Fix for Microsoft Windows 7 1.00 B
[ LightScribe System Software 1.18.11.1
[ Lodack Pro for HP ProtectTools 5.1.0.19
[] LSI High-Definition Audio {HDA) Modem Driver for Microsoft Windows 22580 %
J G Y VA Y, R e e S NS c 1 nAanc -
[« 1 | [n]

8. After selecting the desired SoftPags, the following options are available in the Downloaded SoftPags
window: Download Only, Download and Unpack or Download and Install (Figure A-3).

Figure A-3. Downloaded SoftPags window

Downloaded SoftPaqs

@ Download I EI Explore

Name Version DOWnload Only KB) Date Released Auto Installable  SoftPaq #
Download & Unpack
Download & Install

 Download Only - this option will download all selected SoftPags to “C:\ProgramData\HP\HP
SoftPag Download Manger\SWDownload".

e Download and Unpack - this option will download all selected SoftPags to “C:\ProgramData\HP\HP
SoftPag Download Manger\SWDownload” and unpack each individual SoftPaq in a unique folder
based on SP#: (i.e. \SPxxxxx).

o Download and Install - this option will download all selected SoftPags to “C:\ProgramData\HP\HP
SoftPagq Download Manger\SWDownload” and then install each individual SoftPaq on the current
system.
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Using HP SoftPaq Download Manager to download SoftPags for multiple
platforms

1. Download and install HP SoftPagq Download Manager from www.hp.com/go/sdm on any
Windows based system.

2. Launch HP Softpack Download Manager
3. When prompted, select Show software for all supported models (Figure A-4).

Figure A-4. SoftPagq Download Manager menu

HP SDM is an efficient way of obtaining software and drivers
for HP business computer models.

(") Check software updates for this model.
() Show software for this model only.

@ Show software for all supported models.
[] Do not show this again

4. Select the respective platforms in the Product Catalog window.

5. Select the appropriate Driver and Operating System Enhancement SoftPags from the Available
SoftPags list (Figure A-5).

Figure A-5. Available SoftPags list

Available SoftPags

@ Select SoftPaqs ~ Search for hardware ID Q Show Latest SoftPaqgs
Name Version %
[7] HP Universal Camera Driver CP58500121_F760000z
[7] HP USB 2.0 Docking Station Drivers 55277570
[T HP Wireless Assistant 4042
[ IDT High-Definition (HD) Audio Driver 5.10.6268.0; 6.10.6268.

["] Language Locale ID Fix for Microsoft Windows 7 1.00 B
[ LightScribe System Software 1.18.111 IR
[7] Lodack Pro for HP ProtectTools 51.0.19

[ LSI High-Definition Audio (HDA) Modem Driver for Microsoft Windows 22580 X

|l i VA S Y R e e e c 41 nAanc .
[l m ] [t
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6. Prior to downloading the sofpags, set your download preferences in the Configuration Options
window (Figure A-6) accessed from the Tools menu (Tools -> Configuration Options).

Figure A-6. Download tab in Configuration Options window

r <
[ Configuration Options W SR M

Dodoad Folder (35N Hedture).
C:\SoftPagDownloadDirectory [ Browse
Download Folder Options
@ Single Folder

(7) Separate Folders by SoftPag Names
! Note: Changing this setting does not affect the location of any previously |
downloaded SoftPags.
N
Preview: ]

C:\SoftPagDownloadDirectony\spX0000K exe

: [ ok J[ Cancel |

7. Additional customizations are available through the Unpack tab (Figure A-7).
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Figure A-7. Unpack tab in Configuration Options window

r

Unpacl Directory: ,
C:\SoftPagDownloadDirectory [ Browse

Unpack Folder Options

) Legacy Behavior {unpacks in Download Directory)

() Separate by SoftPaq |Ds (unpacks in Unpack Directory)
@ Separate Folders by SoftPaq Names {unpacks in Unpack Directory)

Note: Changing this setting does not affect the location of any previously
unpacked SoftPags.

Unpack Preview:
C:\SoftPagDownloadDirectory\<category>\<softpag name:>

e Unpack Directory — this field allows the user to change the location where the SoftPags will be
unpacked once they are downloaded.

e Unpack Folder Options

— Legacy Behavior — this option will unpack all selected SoftPags in the Download Directory
established on the Download tab (above). Unpack directory field will be locked.

— Separate by SoftPaq IDs - this option will unpack all selected SoftPags in the folder designated in
the Unpack directory. Individual SoftPags will be unpacked in a unique folder based on SP# (i.e.
\SPxxxxx) according to SoftPaq category (Driver — Video, Driver — Audio, etc.). Figure A-8 shows
an example of this folder structure.
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Figure A-8. Example of folder structure separated by SoftPaq IDs

4 | 2011 Common
4 . Driver - Graphics
 5p52043
. sp52102
4 | Driver - Network
, sp50180
sp51586
.. s5p51988
. sp52131
. sp52209
sp52225

— Separate by SoftPaq Names — this option will unpack all selected SoftPags in the folder designated
in the Unpack directory. Individual SoftPags will be unpacked in a unique folder based on SP
Name (i.e. HP Universal Camera Driver) according fo SoftPaq category (Driver — Video, Driver —
Audio, efc.). Figure A-9 shows an example of this folder structure.

Figure A-9. Example of folder structure separated by SoftPaq Name

4 | 2011 Common
4 . Driver - Graphics
. AMD Video Driver and Control Panel
Intel HD Graphics with Turbo Boost Technology
4 | Driver - Network
. Atheros 2011 Wireless LAN Driver
Broadcom 2070 Bluetooth Software and Driver
. Broadcom Wireless LAN Driver and Utility
. Ericsson Mobile Broadband Drivers
.. Intel 82579LM and 82579V Gigabit Ethernet Driver for Microsoft Windows
. Intel PRO_Wireless Drivers for Microsoft Windows 7

8. After selecting the desired SoftPags, the following options are available in the Downloaded SoftPags
window: Download Only or Download and Unpack (Figure A-10).



Figure A-10. Downloaded SoftPags window

Downloaded SoftPaqgs
ﬁ Download Download & Unpack H Update CVA Files Explore

Name Version, Download Onl KB) Date Released Selected Supported Models SSM-Compliant  SoftPag #
Download & Unpack

 Download Only - this option will download all selected SoftPags according to the settings established
in the Download tab in the Configuration Options dialog. Default is Single Folder set to
“C:\SoftPagDownloadDirectory”.

 Download and Unpack - this option will download all selected SoftPags according fo the settings
established in the Unpack tab in the Configuration Options dialog. Default is Legacy Behavior
(unpack in Download directory) “C:\SofttagDownloadDirectory”.

9. After download is complete, the SoftPags can either be installed directly or imported into your
respective management solution.

For more technical information about using HP SoftPaq Download Manager, please refer to the User
Guide at www.hp.com/qo/sdm.



http://www.hp.com/go/sdm

Appendix B: Sample Sysprep.int files
Example of Windows XP SYSPREP.INF

[Unattended]
OemSkipEula=No

OemPnPDriversPath =
"Drv\Video; Drv\Nic;Drv\Audio; Drv\Modem; Drv\Miscl; Drv\Misc2; Drv\Misc3;Drv\Misc4;Drv\Misc5;Drv\
Chipset;Drv\KBD; Drv\MSD; Drv\USB; Drv\Network"

InstallFilesPath = "C:\1386"

[GuiRunOnce]
CommandO=c:\Drv\install.bat

[GuiUnattended]
AdminPassword=*
EncryptedAdminPassword=NO
AutoLogon=Yes
AutoLogonAccountCreation=NO
AutoLogonCount=1
OEMSkipRegional=0
OemSkipWelcome=0
WaitForReboot=NO

[UserDatal

ComputerName=*

[RegionalSettings]
LanguageGroup=1

[Identification]
JoinWorkgroup=WORKGROUP

[Networking]

InstallDefaultComponents=Yes

[OFM_Ads]
Background=BACKGRND.BMP

[Datal]
UseBIOSToBoot=1

[SysprepMassStorage]

PCI\VEN 8086&DEV_ 2410 = %systemroot%\infi\machine.inf ; INTEL PCI-ISA bridge
PCI\VEN 1106&DEV_0571 = %systemroot%\inf\mshdc.inf ;VIA IDE controller
PCI\VEN_10DE&DEV_01BC = %systemroot$\infl\mshdc.inf ;NVidia IDE controller
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Example of Windows 7 SYSPREP. XML

<?xml version="1.0" encoding="utf-8"?>
<unattend xmlns="urn:schemas-microsoft-com:unattend">
<settings pass="oobeSystem">
<component name="Microsoft-Windows-International-Core" processorArchitecture="x86"
publicKeyToken="31b{3856ad364e35" language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlins:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<Inputlocale>en-us</Inputlocale>
<Systemlocale>en-us</Systemlocale>
<UlLanguage>en-us</Ullanguage>
<UlLanguageFallback>en-us</UlLanguageFallback>
<Userlocale>en-us</Userlocale>
</component>
<component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35"
language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<OOBE>
<HideEULAPage>true</HideEULAPage>
<Networklocation>Work</Networklocation>
<ProtectYourPC>1</ProtectYourPC>
<SkipUserOOBE>true</SkipUserOOBE>
</OOBE>
<RegisteredOrganization>Bmankind</RegisteredOrganization>
<RegisteredOwner>Bmankind</RegisteredOwner>
<UserAccounts>
<localAccounts>
<localAccount wem:action="add">
<Password>
<Value>cABhRAHMAcwB3AG8AcgBKkAFAAYQBzAHMAJWBVAHIAZAA=</Value>
<PlainText>false</PlainText>
</Password>
<Name>UserA</Name>
<Group>administrators</Group>
<DisplayName>UserA</DisplayName>
</localAccount>
</LlocalAccounts>
<AdministratorPassword>

<Value>cABhAHMAcwB3AG8AcgBKAEEAZABIAGKAbgBpAHMAJABYAGEAJABVAHIAUABhAHMACWB3AG8AcgBkAA==</V
alve>
<PlainText>false</PlainText>
</AdministratorPassword>
</UserAccounts>
</component>
</settings>
<seftings pass="auditSystem">
<component name="Microsoft-Windows-PnpCustomizationsNonWinPE" processorArchitecture="x86"
publicKeyToken="31b{3856ad364e35" language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlins:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<DriverPaths>
<PathAndCredentials wem:keyValue="dfbbff91" wem:action="add">
<Path>C:\Drv</Path>
</PathAndCredentials>
</DriverPaths>
</component>
<component name="Microsoft-Windows-Deployment" processorArchitecture="x86"
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"

18



xmlins:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.0org/2001/XMLSchema-
instance">
<Reseal>
<Mode>Audit</Mode>
</Reseal>
<AuditComputerName>
<MustReboot>false</MustReboot>
<Name>*</Name>
</AuditComputerName>
</component>
<component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35"
language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<Autologon>
<Username>Administrator</Username>
<Enabled>true</Enabled>
<LlogonCount>3</LogonCount>
</Autologon>
</component>
</seftings>
<settings pass="specialize">
<component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35"
language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlins:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<ProductKey>xxxxx-xxxxx-xxxxx-xxxxx-xxxxx</ProductKey>
<ShowWindowslive>false</ShowWindowslive>
<TimeZone>Eastern Standard Time</TimeZone>
<Display>
<ColorDepth>32</ColorDepth>
<DPI>106</DPI>
<HorizontalResolution>1280</HorizontalResolution>
<RefreshRate>75</RefreshRate>
<VerticalResolution>1024</VerticalResolution>
</Display>
<ComputerName>*</ComputerName>
<CopyProfile>true</CopyProfile>
</component>
<component name="Microsoft-Windows-Security-Licensing-SLC-UX" processorArchitecture="x86"
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<SkipAutoActivation>true</ SkipAutoActivation>
</component>
<component name="Microsoft-Windows-UnattendedJoin" processorArchitecture="x86"
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"

xmlns:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance">
<Identification>
<Credentials>
<Domain>arbor01</Domain>
<Password>nopass</Password>
<Username>installman</Username>
</Credentials>
<JoinDomain>arbor01</JoinDomain>
</I|dentification>
</component>
<component name="Microsoft-Windows-Deployment" processorArchitecture="x86"
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"
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xmlins:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
<RunSynchronous>
<RunSynchronousCommand wem:action="add">
<Order>1</Order>
<Path>net user administrator /active:yes</Path>
</RunSynchronousCommand>
</RunSynchronous>
</component>
</settings>
<cpi:offlinelmage cpi:source="wim:d:/sources/install.wim#Windows 7 ULTIMATE" xmlns:cpi="urn:schemas-microsoft-
com:cpi" />
</unattend>

Appendix C: Installing Preboot applications and tools

The HP TOOLS partition and the preboot applications on the partition are not required for the basic
operation of HP notebook computers. However, if the HP_TOOLS partition or applications are missing,
the features described in this paper will not be available.

Applications accessible during startup
The HP_TOOLS partition includes the following applications and utilities:

. HP System Diagnostics - allows you to perform diagnostic tests on select system components
. BIOS Recovery — automatic BIOS corruption detection aand recovery

Creating or restoring an preboot partition on the hard drive
Use the following steps to create the HP preboot partition and install preboot SofPags onto the partition:

1. Use Partition Magic or a comparable utility to create a partition on a local hard drive that has a
System partition with the following characteristics: Partition type: FAT32 Partition size: 5 GB Volume
name: HP_TOOLS

2. In the new partition, create a folder called HEWLETT-PACKARD.

3. In the HEWLETT-PACKARD folder, create the following sub-folders:

-SYSTEMDIAGS

-BIOS

4. In the BIOS folder, create a Current subfolder

5. Download the SoftPags for System Diagnostics and BIOS to the operating system partition. SoftPags
are available from http://www.hp.com/support.

6. Verify that the Softpags run and unbundle into the C:\swsetup directory.

7. Verify that the preboot application is installed in the correct location in the FAT32 partition
8. Verify that all preboot applications have signature (.sig) files.

9. Verify that each application works properly after installation.

HP_TOOQLS partition errors

If the preboot application launch keys fail to operate, the partition may have become corrupt.
Reinstall the application using the related SoftPaq from http://www.hp.com/support. If a reinstalled
preboot application does not work after reinstallation, contact technical support.
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The following errors may be displayed if a problem occurs when launching EFl and preboot
applications:

. Preboot partition not found: can’t find FAT32 partition starting with HP_TOOLS.
. Application not found: can’t find preboot application in directory.
. Invalid signature: BIOS fails to verify the signature of the preboot application.

If there is a backup version of the application in BIOS flash (for example, HP System Diagnostics).

BIOS will launch the backup. Otherwise, BIOS displays an error message.

WARNING

Do not encrypt HP_TOOLS partition using software encryption
programs such as Windows Bitlocker or Full Volume Encryption for
HP ProtectTools. When the partition is encrypted, the HP preboot
applications cannot function.
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